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1 Introduction 
 

1.1 Warnings, Cautions and Notes 
 
This manual contains important information regarding the operation of the 3MTM RTE8000 HS Family scanners.  
For safe and reliable operation of the scanners all users must ensure that they are familiar with and fully 
understand all instructions contained herein. 

 
Danger indicates a hazardous situation which, if not avoided, will result in death or 
serious injury. 

 
Warning indicates a hazardous situation which, if not avoided, could result in death or 
serious injury. 

 
Caution indicates a hazardous situation which, if not avoided, could result in minor or 
moderate injury. 

 
Notice indicates a situation which, if not avoided, could result in property damage only. 
This includes situations which require you to re-install your software or return your 
equipment to the manufacturer for recalibration. 

 
Information indicates important information that helps get the optimum performance 
from your scanner and will save you time during evaluation and deployment. 

 
Proprietary Statement 

 
By using the 3MTM  RTE8000 HS Family scanners  product range (the “Product”), you (the “User”), agree to be 
bound by the following terms and conditions. 
 
Because use of the Product varies widely and is beyond the control of 3M,the User must evaluate and 
determine whether a Product is fit for a particular purpose and suitable for User’s application prior to use. THE 
FOLLOWING IS MADE IN LIEU OF ALL EXPRESS AND IMPLIED WARRANTIES OR CONDITIONS 
(INCLUDING WARRANTIES OR CONDITIONS OF SUITABILITY AND FITNESS FOR A PARTICULAR 
PURPOSE). If a Product is proved to be defective (the “Defective Product”), the exclusive remedy, at 3M’s 
option, shall be to either repair or replace the Defective Product or refund the purchase price of the Defective 
Product. 
 
LIMITATION OF LIABILITY: OTHER THAN IN RELATION TO DEATH OR PERSONAL INJURY CAUSED BY 
ITS NEGLIGENCE 3M AND SELLER, IF ANY, SHALL NOT BE LIABLE FOR ANY INJURY, LOSS OR 
DAMAGE, WHETHER DIRECT, INDIRECT, SPECIAL, INCIDENTAL OR CONSEQUENTIAL HOWSOEVER 
CAUSED, (INCLUDING DAMAGES FOR LOSS OF PROFITS, BUSINESS INTERRUPTION, LOSS OF 
BUSINESS INFORMATION, INCREASED COSTS OF OPERATION, LITIGATION COSTS AND THE LIKE), 
WHETHER BASED UPON A CLAIM OR ACTION IN CONTRACT (INCLUDING BREACH OF WARRANTY), 
TORT, (INCLUDING NEGLIGENCE) OR OTHERWISE, IN CONNECTION WITH THE USE OR 
PERFORMANCE OF A PRODUCT. 
 

© 2010, 3M.  All rights reserved 
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No part of this publication may be reproduced, transcribed, stored in a retrieval system or transmitted in any 
form whatsoever, without the prior written consent of 3M. 
 

1.2 Notices 
 
The company reserves the right to make changes to its products at any time and without notice.  The 
information furnished by the company in this manual is believed to be accurate and reliable.  The material 
contained herein is supplied without any representation or warranty of any kind.  The company therefore 
assumes no responsibility, consequential or otherwise, of any kind arising from the use of this product.   
 

1.3 Trademarks & Acknowledgements 
 
3M and Confirm are trademarks of 3M.  
U.S. Pat Nos. 6,019,287 and 6,611,612 
 
Windows, Visual C++ and Visual Basic are registered trademarks of Microsoft Corporation in the United States 
and other countries. C++ Builder and Delphi are trademarks or registered trademarks of Embarcadero 
Technologies, Inc. or its subsidiaries in the United States and other Countries. Java is a trademarks or 
registered trademarks of Sun Microsystems, Inc. or its subsidiaries in the United States and other countries. 
 
All other names contained herein are for reference only and are the property of their respective owners. 
 
All trademarks are acknowledged. All 3M trademarks are trademarks of 3M Company. 
 

1.4 Electromagnetic compatibility (EMC) 
 
The Products are designed to be immune to levels of interference generated within an office environment and 
not to interfere with other equipment. In order to provide this level of compatibility the Product, its cabling and 
PSU or its installations, must not be modified in any way. 
 

 
Modifications or changes to the Product, the interface cables or the power supply 
not expressly approved by the manufacturer could void the User's authority to 
operate the Product and/or break local laws or regulations. 

 
For further regulatory information or copies of certificates contact your local 3M representative or the 
manufacturer at 3M-AiT-gcs@mmm.com 
 

EMC Compliance Europe 
 

 

The Product meets the following European Council Directives:  
 
Scanner: EMC (2004/108/EC), RFID Option RE&TTE (1999/5/EC) 
 
PSU: EMC (2004/108/EC), LVD (2006/95/EC) 
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USA Radio Frequency Rules and Regulations (FCC Notice) 
 
NOTE: This equipment has been tested and found to comply with the limits for a Class A digital device, 
pursuant to Part 15 of the FCC Rules. These limits are designed to provide a reasonable protection against 
harmful interference when the equipment is operated in a commercial environment. This equipment generates, 
uses, and can radiate radio frequency energy and, if not installed and used in accordance with the instruction 
manual, may cause harmful interference to radio communications. Operation of this equipment in a residential 
area is likely to cause harmful interference in which case the user will be required to correct the interference at 
his own expense. 
 

FCC Notice - RFID Option 
 
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two conditions: 
(1) This device may not cause harmful interference, and 
(2) this device must accept any interference received, including interference that may cause undesired 
operation. 
 
FCC ID: DGF-SSDRTE8000 
 
Modifications to the device shall not be made without the written consent of 3M Company. Unauthorized 
modifications may void the authority granted under Federal Communications Commission Rules permitting the 
operation of this device. 
 
 
 
Industry Canada Radio Frequency Rules and Regulations 
 
This Class A digital apparatus meets all requirements of the Canadian Interference-Causing Equipment 
Regulations. 
Cet appareil numérique de la classe A respecte toutes les exigences du Règlement sur le matériel brouilleur du 
Canada. 
 
IC ID : 458A-SSDRTE8000 
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1.5 Disposal - European Directive 2002/96/EC 
 
 

 
 
 

Do not dispose of this equipment in domestic or general waste. These devices 
can be recycled and should be disposed of in accordance with your local and 
national regulations. 

 
 

 
For UK customers who have equipment supplied after August 2005 please contact 
3M Rochford Thompson to arrange for the disposal of this equipment.  

Do not send equipment back to 3M Rochford Thompson unsolicited. 

 

1.6 Packing for transportation 
 
When packing this product for repair or shipment carefully disconnect cables and PSU and pack in the original 
inner and outer packaging cartons. 
 

1.7 Revision History 
 

Version Date Description 

V1.00 July 2009 Original  

V1.1 June 2010 New manual style, minor corrections, 
clarifications, added additional regulatory 
information and improved technical 
specification. 

 

1.8 References 
 

Description RT Part No. 

3MTM RTE8000 HS Getting Started Guide 97-0183-03 

3MTM Page Reader SDK Programmers’ Guide 97-0183-10 

3MTM RTE8000 Self-Service Integration Manual 97-0183-21 

3MTM Page Reader eMRTD QA Application Guide 97-0183-01 

For authorised Repairs Centres only - 3MTM RTE8000 Maintenance 
Guide 

97-0183-78 
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1.9 Sales Office Locations 
 
 The Americas  
 1545 Carling Avenue  
 Suite 700  
 Ottawa, Ontario  
 CANADA  
 K1Z 8P9  
 telephone:  +1 613 722 2070 
 fax:   +1 613 722 2063 
 web:   http://www.3m.com/security/en 
   
   
 Europe, Middle East and Africa 
   
   
 3M Rochford Thompson  
 The Votec Centre  
 Hambridge Lane  
 Newbury  
 RG14 5TN  
 UK   
 telephone:  +44 (0) 1635 580 666 
 fax:  +44 (0) 1635 369 40 
 Web:  http://www.passport-scanners.com 
   
   
 Asia, Pacific and Australasia 
   
 3M Asia Pacific Pte Ltd  
 Security Systems Division  
 1 Yishun Avenue 7  
 Singapore 768923  
 telephone:  +65 6450 8888 
 fax:  +65 6458 5432 
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1.10 Global Technical Services 
 
 The Americas 

   

 direct line:    +1 613-722-3629 

 main number:  +1 613-722-2070 

 fax:  +1 613-722-2063 

 email:   3M-AiT-gcs@mmm.com 

   

   

 United Kingdom  

   

 direct line:  +44 (0) 1635 264 140 

 main number:  +44 (0) 1635 580 666 

 fax:  +44 (0) 1635 369 40 

 email:   gcs-uk@mmm.com 

   

   

 Asia, Pacific and Australasia 

   

 telephone:  +65 6450 8888 

 fax:  +65 6458 5432 
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2 Executive Overview 
 
The 3MTM RTE8000 HS is a family of versatile full page scanners which speedily captures data from passports, 
visas, tickets and other travel documents and takes images in multiple lights for record keeping, document 
authentication and biometric analysis. A fully integrated RFID reader reads the ePassport chip at the same time 
as the camera scans the document. Designed by 3M Rochford Thompson who has over 20 years in document 
reading technology the 3MTM RTE8000 HS has many exceptional features, such as active video and 2D 
barcode reading from mobile phones.  
 
The 3MTM RTE8000 HS is supported by a Software Development Kit which provides simple integration of the 
scanner and its functions into your application and is backed up by 3M Rochford Thompson’s dedicated 
technical support team. Virtually maintenance free the 3MTM RTE8000 HS full page scanner fits into any 
environment whether kiosk or desk mounted. The 3MTM RTE8000 HS has an exceptional track record and is in 
use by governments and major corporations throughout the world.  
 

What is a Full Page Scanner? 
 
Unlike a swipe reader a full page scanner takes an image of the complete page of the travel document. This 
allows the whole page to be examined and data from any part of the page to be recovered. It is ideal for 
ePassports where the OCR data must be read first to access the chip and a single operation recovers the visual 
and RFID data. The full page scanner usually has multiple lights sources, not only the IR light required to read 
the data from the passport but also white light and UV which gives additional security checking.  
 

What’s special about the 3MTM RTE8000 HS? 
 
There are many features that make the 3MTM RTE8000 HS special and its flexibility makes it difficult to describe 
all the features. These are the top few:  
 

•  A fully integrated RFID reader completely reads the ePassport chip at the same time as the camera 
scans the document. 

•  Reads 2D barcodes from tickets, dockets, boarding cards and home print check-in documents as well as 
2D barcodes off cell/mobile phones.  

•  A small footprint makes it ideal for use on airline check-in desks and immigration control booths.  

•  The scanners have no motorised moving parts ensuring maximum reliability and low maintenance.  

•  Many options with a variety of hood designs for optimal operator convenience. 

•  User friendly and flexible software integration and installation tools supporting most languages. 

•  Very easy to add new document types e.g. landing cards makes the 3MTM RTE8000 HS future proof. 

•  Active Video allows the document to be placed at any angle and improves the read rate for casual users 
which is especially useful for ID cards, driver’s licences and for use in Self Service Kiosks. 

•  Excellent track record of sales to many types of organisation. 
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Why buy from 3M Rochford Thompson? 
 
3M Rochford Thompson has over 20 years experience in document scanning technology and 15 years in the 
airline and immigration business. It designs advanced scanning products which are in use all over the world. An 
exceptionally committed team of hardware and software engineers are there to help resolve any technical 
problems. 
 

Why should your organisation use the 3MTM RTE8000 HS? 
 
The 3MTM RTE8000 HS is an excellent data capture device and its first time, every time read rate minimises 
queuing during passenger processing both at Self Service Kiosks and at employee operated control points.  
 
Accurate data along with document authentication and the capability to add new document types reduces 
attempts by criminals and asylum seekers to gain entry to a country or access services they are not entitled to. 
For an airline this keeps immigration and ID check fines to a minimum.  
 
The 3MTM RTE8000 HS supports a very wide range of documents and security checks and its Software 
Development Kit (SDK) provides the freedom to add new documents makes your investment in the 3MTM 
RTE8000 HS safe. 
 

Who uses page scanners and why? 
 
These are some examples: 

•  Airlines APIS data capture with cross checking of FAA watch lists 

•  Border control and immigration ePassport reading and authentication 

•  Ferry companies Electronic manifests with traveller photo images 

•  Cruise lines Scanning full colour or greyscale images of travel documents 

•  Police forces ID checks 

•  Railway companies Ticket fraud detection 

•  Car Hire firms Travel document authentication 

•  Hotels  Hotel check-in and reporting 

 
How do I evaluate the 3MTM RTE8000 HS? 
 
This manual describes how to install the scanner and the evaluation programs available to evaluate its 
performance. You can be reading your first document using the 3MTM Page Reader Expo program in less than 5 
minutes. For a detailed analysis of RFID ePassports then use the eMRTD Reader program. Look at section 4.2 
below. 
 
If you are a developer you may wish to try the various SDK application and language samples to help you 
decide on your integration strategy (see the section on Sample Applications in the 3MTM Page Reader 
Programmers' Guide for more detail). 
 
Detailed specifications for the 3MTM RTE8000 HS are provided in Appendix A. 
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How do I integrate the 3MTM RTE8000 HS into my business? 
 
First decide which functions you require the scanner to perform and at which points in your processing. You 
also need to consider the documents you need to be read, the data required from them and the security checks 
to be preformed. Finally determine what data, including images, you will store. 
 
The 3MTM Page Reader SDK Programmers’ Guide shows you many ways to use the SDK to integrate the 
scanner into your application and development environment and generally this can be done with little 
programming effort and minimal changes to the business process. The SDK gives you both high level functions 
(you can have a sample program running in minutes) and yet provides very precise control of individual images 
if required. The SDK supports most programming languages as well as other methods of integration such as 
keyboard wedge and web page screen scraping. 
 
The scanner has fixings to help with physical integration and the Integration Manual covers all electrical and 
mechanical aspects. Our technical support team is on hand to help you with any questions that arise. 
 
The SDK is regularly updated with enhancements and the latest software techniques especially for the 
emerging ePassport standards. 
 

Customisation 
 
The 3MTM RTE8000 HS is a sophisticated scanner with lots of options available. All of these options are 
available for you to change so you get the best performance and have the scanner work the way you want it to. 
 

Problems 
 
In the first instance refer to the Troubleshooting section 4.6 below. If this doesn’t help then either contact your 
distributor or 3M Rochford Thompson.  Cleaning instructions are given at the end of this manual. 
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3 Scanner overview 
 

3.1 Introduction 
 
The 3MTM RTE8000 HS is a family of versatile multi-function scanners, designed to read the full page of 
passports, visas and other travel documents and capture multiple images for use in document authentication 
and biometric analysis. A fully integrated RFID reader can be included to completely read the ePassport chip at 
the same time as the camera scans the document. 
 
Their small footprint makes them ideal for use on airline check-in desks and immigration control booths.  The 
scanners have no motorised moving parts ensuring maximum reliability and low maintenance. 
 
 

 

The 3MTM RTE8000 HS (shown on left) has a 
semi-enclosed (enhanced) hood to hold the 
document and give high quality UV images 
regardless of the ambient light. In addition the 
hood helps to hold the document in place which 
is useful when reading and writing e-Passports. 
It has been designed to be used with one hand, 
even if gloved, and can be used with full sized 
passports or small ID cards. The enhanced hood 
is generally designed for use by immigration 
authorities. The enhanced hood can be supplied 
with either one side closed or both sides closed 
(typically used for QA and issuance). 

  
 

 

The 3MTM RTE8000 HS SSD (shown on left) is 
designed for use in self-service kiosks and 
automated border control systems. It has a half-
length hood making it very easy to place a 
document. Its simplicity of use makes it ideal for 
self-service kiosks where a large number of un-
initiated passengers will be checking in for 
international flights. 
 
Various other hood options are available 
please contact your supplier for more 
information. 
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3.2 Applications 
 

•  Border control 

•  ePassport reading and authentication 

•  APIS data capture with cross checking of FAA watch lists 

•  Scanning full colour or greyscale images of travel documents 

•  Electronic manifests with traveller photo images 

•  Hotel check-in and reporting 

•  ID checks 

•  Airline ticket fraud detection 

•  Travel document authentication 

 

3.3 Features  
 
This section gives a basic description of the important features of the 3MTM RTE8000 HS scanner and its 
software. It can be used to cross check against a requirements set. Items marked as [Option] are not 
necessarily part of the standard package; please talk to 3M Rochford Thompson about these options.  A 
technical specification is given in Appendix A. 
 
3.3.1 Overview 
 

•  A wide range of documents can be read optically with the 3MTM RTE8000 HS scanner family: 

 - Machine readable travel documents including passports, visas and ID cards. 

 - The range of US issued special documents including Refugee Travel Documents, Re-entry 
Permits, Permanent Residence Cards and Border Crossing Cards. 

 - Barcoded documents containing 1D or 2D barcodes such as 2D boarding pass, TAT and ATB 
airline tickets, bag-tags, shipping labels, identity cards, etc [Option]. Most common barcode 
symbologies supported. 

 - e-Passports conforming to ICAO standards providing Basic Access Control, Active 
Authentication, data group retrieval, feature extraction, hash validation and signature verification 
[Option]. 

 - Specialist documents such as landing cards or driver’s licences [Option]. 
  

•  e-Passport reader (RFID option) fully integral with scanner so operator can read the OCR and 
smartcard chip in one operation. [Option]. 

•   400 dpi camera. 

•  Captures full colour or greyscale images of all travel documents including non-ICAO passports. 

•  Uses multiple light sources for image capture and document authentication – visible (RGB), infra red 
(IR), ultra violet (UV-A). 

•  Various hood types for different applications. 

•  SDK. Flexible software interface allows host application to select which illumination sources to use, 
image type, image compression, photo extraction, etc. 
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3.3.2 Operation 
 

•   “Lay on” scanner, single handed operation. Semi-enclosed enhanced hood holds document in 
place during reading. 

•  Accepts documents in any orientation. 

•  Automatic document detection. 

•  Simple, intuitive and quick operation by passengers. 

•  Small footprint, no moving parts, robust construction. 

•  Supports remote monitoring in kiosk and networked environments. 

•  On/off switch [Option].  

•  Auxiliary USB2.0 interface for webcam, fingerprint scanner or other biometric device [Option]. 

 
3.3.3 Images taken and received 
 

The scanner’s basic function is to take images and the following images can be taken and retrieved: 

•  Infrared image of the whole document or the codeline region (greyscale). 

•  Visible (i.e. white) light image returned as either a 24 bit colour or greyscale image. 

•  UV image in 24 bit colour. 

•  Detection of the location of the photograph on the document, extraction of it and automatic 
colour and brightness adjustment. 

•  Images are generally supplied in jpeg format at a user selectable compression but other 
formats such as BMP and PNG are available as an option. 

 
3.3.4 RFID option – features 
 
All data groups, hashings, validations, BAC, Active Authentication and Extended Access Control are supported. 
A fully featured PKI with certificate chain management is implemented. 
 
The RFID option can be used to write to ISO 14443 chips. This means that the 3MTM RTE8000 HS can be used 
to personalise e-Passports during issuance and manage additional chip applications.  
 
There is an internal connector for a Security Access Module (SAM) [Option]. 
 
3.3.5 Specialist check features 
 

Specialist check features include: 
  

•  Checksum validation on ICAO format OCR codelines. 

•  Infra red and UV paper security checks. 

•  Quality assurance check on OCR, HRZ and RFID for use during production of e-
Passports [Option]. 
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3.3.6 Other features 
 

Other features include: 
  

•  Auto detect of document position followed by rotation and cropping to produce a “right 
size, right way up” image of the document. 

•  Additional OCR data can be read from the human readable part of a visa in order to 
provide extra information on the validity, number of entries and type of use of the visa 
[Option]. 

•  UK Drivers’ Licences module for OCR of the driver’s personal data [Option]. 

•  Ability to add special document types and processing including handwriting recognition. 

 

3.3.7 Construction 
 
The scanner is constructed from plastic components with a metal wrap around cover to give it strength and 
stability. It has a glass top which incorporates the viewing window and two tri-colour LEDs for user feedback. It 
uses a USB2.0 connection to the host computer. Other points to note are: 
 

•  Standard tops are the half width open hood (SSD model) or the semi-enclosed 
enhanced hood. Other top styles are available (contact your supplier for more details). 

•  USB2.0 host port connection for additional devices such as finger print scanners, pen 
drives, etc [Option]. 
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4 Evaluating the 3MTM RTE8000 HS Scanner 
 

4.1 Installation 
 

 
Do not plug the reader in before installing the 3MTM Full Page Reader Drivers 
Setup. 

You must install the drivers first. 
 
PC must run Windows 2000 SP4, Windows XP SP1-3, Windows Vista or Windows 
7. You must use a USB 2.0 port. 

 
 
For a full description of the installation you need to read Section 6, but for the experienced user the process 
can be summarised as follows: 
 

•  Install the full 3MTM Page Reader SDK (do not plug the scanner in first) ensuring the 
3MTM Full Page Reader Drivers are installed. 

•  For optimum performance ensure at least DirectX 9 is loaded and up to date. 

•  Connect the scanner up and follow the instructions when the "driver install" windows 
appear. 

 
Once the software is installed, use this manual to help with the set up, running and control of the scanner. The 
next section explains how to start using the scanner. 
 
For the system requirements of the PC you are installing the reader on to, see Appendix A within the 3MTM 
Page Reader Programmers' Guide. 
 

4.2 Reading a document 
 
This section explains how to read a document using the 3MTM Page Reader Expo application using the default 
scanner settings. Ensure that the software and drivers have been installed from the 3MTM Page Reader SDK 
CD. 
 

1.  Connect the scanner to the PC via a USB 2.0 port. 
  
2.  Plug the power into the scanner. 
  
3.  Start the 3MTM Page Reader Expo from the desktop shortcut.  This should start a test application. 
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4.  Place a document on the scanner glass as 

follows: 

 
   
   
 Ideally the document should be pushed right into 

the corner against the back and left edges of the 
scanner, but the document will read if it is placed 
anywhere towards the back of the glass: 
 
Depending on your requirements try a variety of 
different documents, for instance passports, 
visas, identity cards and barcodes. 

 
   

 
 

 
Note:  Not all options may be available on your scanner/software combination. 

 
 

 Also try reading documents in different positions, upside down and rotated at angles, for 
instance and identity card at right angles.  Tips for a good read: 

  

•  A straight document reads faster than a rotated document. 

•  A document with the codeline positioned to the back of the scanner reads faster than a 
document which is the other way around. 
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5. If the default sound scheme is in use then the scanner will beep twice, the first beep signifies 

that the document has been found and it should be held still for scanning, the second beep 
signifies that the document can be removed. If the default LED scheme is in use then a green 
light signifies a good read and a red light signifies an error in the read. Sections  5.2.1.3 and  
5.2.1.4 explains the sound and light schemes in more detail. 

  
6. Remove the document and place another document on the glass to read again. The reader 

should read any passport, visa or ID card with a machine readable data zone. Depending on 
the configuration and options on your reader you may be able to read various barcodes and 
RFID documents. For a full list of documents see section  5.2.1.1 and Appendix A. 

 
If you cannot get a read then see the section 4.6 on troubleshooting, otherwise continue reading for a 
description of the main evaluation tools.  
 

4.3 Evaluation Tools 
 
The 3MTM Page Reader Expo application is the main tool for the evaluator to understand the scanner and its 
modes of use. Once familiar with this application the evaluator may wish to try the various SDK application 
samples which allow you to decide the best method of developing an application (see the section on Sample 
Applications in the 3MTM Page Reader Programmers' Guide). 
 
For a detailed analysis of the scanner’s capabilities when used with RFID ePassports then use the eMRTD 
Reader test program (see section 4.5). 
 
 
Try using various documents and scan them in different orientations.  
 

 
Note:  Documents can be scanned by simply inserting them as shown below. 
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4.4 Page Reader Expo 
 
The 3MTM Page Reader Expo application can be used to customise the scanner and then display the data read 
from documents.  A screenshot of the main Expo window is shown below: 
 

 

 
In this screenshot images from the scanner are displayed along with the codeline and checksum information.  
The Expo automatically breaks up ICAO conforming document codelines into the individually displayed fields 
and the document type (see box top left).  The tabs across the top allow various configuration options to be 
changed. The status bar at the bottom contains the following in left to right order: 
 

•  Blue toggle block shows a new document has been read. 

•  Name of the scheme in use. 

•  Scanner status: should be “Enabled”. If “Asleep” or “Disabled” then use the control box to enable 
the scanner.  If “Terminated” or “Errored” then you have a problem (see error report to the right of 
this field and for more complex problems see the Troubleshooting Section 4.6 for more help).  

•  The progress bar which oscillates as data is being received. 

•  Message about the last scanner data message received. 

•  Error report. 
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Clicking on an image opens it in a larger window where it can be zoomed and panned for closer inspection. 
 
Because the 3MTM Page Reader Expo can be user configured it can be used both for evaluation and for real 
world applications. Additional features include watch-list and image storage. 
 
4.4.1 Starting the 3MTM Page Reader Expo 
 
When the 3MTM Page Reader Expo starts it normally displays the Scheme selection menu (see later). Select the 
scheme that you wish to use for the task in hand. Selecting a scheme does not change any of the configuration 
files stored in the scanner as it temporarily overrides them. The settings stored in the scanner can be used 
rather than a predefined scheme by selecting the ‘Use scanner settings’ option on the Schemes Selection 
screen.    
 
If you don’t require this screen to appear on each startup then untick the “Show this screen on startup” check 
box. 
 
 
4.4.2 Controls 
 

Reset: Sends a reset command to the scanner and sets the 
configuration required by the scheme in use. 

 

Save Config: Fixes the scheme's configuration as a permanent 
setting in the scanner’s configuration files. 

Camera Type: Displays the dpi of the camera. 

Logging: If checked it will create a log file called 
PageReaderExpo.log in the current directory. 

 

Images: The images, RFID, barcode and OCR data can be 
saved.  Only data retrieved by the scheme will be 
saved. Check the box to save all data from all scans or 
only save the last scan.  

Text Only: Saves text data such as codelines. 

Reset Numbering: Set saved data index to zero. 

Change Save Dir: Select the folder in which to store the data.  
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Save Positions: Fixes the boxes in place for this scheme otherwise 
movements will be discarded when the program closes. 

Default Positions: Sets the boxes to their default locations. 

Change Background: Select an image for the background, for instance a 
company logo. 

Default Background: Returns the background to plain grey. 

Show Control: Turns on the display of the Enable, Disable and Sleep 
scanner command box. 

 

Watch-list and database functionality can be used to automatically match 
documents to a database. 

Watch-list: Highlights documents that are present in a watch-list. 
Red for a match, green for no match.  

Database: Highlights documents that are not in a database. Green 
for a match, red for no match. 

Add Document: Click to add the current document to the database or 
watch-list. 

 

 
 
The scanner can be enabled, disabled and put into sleep mode via buttons in the control window. 
 
 
4.4.3 Creating and Using Schemes 
 
Pre-defined schemes are created in the Expo to demonstrate different functions of the scanner. For example, 
an RF scheme, an images scheme, a barcode scheme and a general scheme that displays everything may be 
required.  
 
The following screenshot shows the scheme selection window: 
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When a scheme is selected the relevant data items are displayed in the main window and the scanner only 
processes and sends those items. Selecting a scheme does not affect the settings stored in the scanner. There 
is a menu item to update the scanner settings on the main screen if required. The Expo will display and 
automatically size and arrange the relevant data items if this option is selected. 
 
The schemes are easily created and can be selected by hotkey or via the schemes menu option. The following 
screenshot shows the ‘RF Images Barcode’ scheme in the scheme editor: 

 
 

 

Note:  You can change the image compression used on the displayed and saved 
images. 0 is the least compression (most detail and largest size) whilst 100 is 
maximum compression.  
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The appearance of the Expo can be changed as required. For example, data items are automatically positioned 
and sized but they can be manually resized and repositioned using the mouse. The layout can be saved at any 
time for each scheme. The background can also be changed to any desired image. The following screenshot 
illustrates: 
 

 
 
4.4.4 Things to Check 
 

•  Check that the document is appropriate for the scheme. 
•  If the document is not being read then check the images to see it is being captured correctly 
•  The Enable mode is required for reading document. Turn on the Layout – Show Controls 

feature. 
•  Check the reader status and error messages in the lower message bar. 
•  Turn on logging and check the log file. 
•  Try restarting the program or sending the scanner a reset. 
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4.5 eMRTD Reader 
 
The eMRTD Reader program is a tool for the detailed analysis of ePassports and their communications with the 
scanner. It is very useful if you need to understand how the 3MTM RTE8000 HS interacts with ePassports and 
the features available in the 3MTM Page Reader SDK. It can also be used to analyse the contents of an 
ePassport. 
 
The eMRTD Reader program can be started by double clicking the eMRTD Reader desktop icon or going to the 
3M Page Reader group in the Start -> Programs menu. The introductory screen looks like this: 
 

 
 
The program is split into 7 tabs, as follows: 
 

1. Passport displays generic information about the current passport in the Details list, 
and displays the progress of the current read. 

2. Data Groups displays all the data groups returned and validated. 

3. DG1 displays the decoded DG1 MRZ/codeline data. 

4. DG2 displays the decoded DG2 face image. 

5. DG3 displays the decoded DG3 fingerprint images (if available). 

6. Timings displays how long each item took to download. 

7. Messages displays information, warning and error messages generated during a 
document read. 
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4.5.1 Initialising the Program 
 

1. Ensure that the scanner is plugged into your PC and switched on. 

2. Start the program using either the desktop or Start menu shortcuts. 

3. The program will start, and will automatically connect to the scanner. 

4. If you wish to use the scanner to capture the optical MRZ for Basic Access Control (BAC), 
make certain that the “Use scanner for OCR and doc detect” menu option is checked under 
the Options menu. If it is not, click on File -> Disconnect (if already connected), click on 
Options -> Use scanner for OCR and doc detect to display the tick, then click File -> 
Connect to re-initialise. If this option is not checked, you must manually initiate a read by 
clicking the “Read Now” button on the Passport tab. 

5. Place an ePassport on the scanner and hold it in place until it has finished reading. If the 
BAC fails, then the program will display a manual correction box. 

 
4.5.2 Understanding the Data Displays 
 
After a document read, the Passport tab will look similar to this: 
 

 
 
The Passport tab will display generic information about the ePassport, such as the average transfer speed, chip 
ID, air baud rate, and various validation checks (e.g. Basic Access Control, Signature, etc.) 
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The Data Groups tab will look similar to this: 

 

The Data Groups tab will display all the validated data groups, and you can view all the raw data group files 
downloaded from the ePassport chip. You then have the option to save the raw files for later inspection.    
 
The DG1 tab will look similar to this: 

 
 
The DG1 tab displays the decoded MRZ data. It shows the entire codeline as a whole, plus broken into fields 
according to ICAO9303.   
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The DG2 tab will look similar to this: 

 

The DG2 tab displays the decoded face image. JPEG2000 images are supported.   

The DG3 tab will look similar to this: 

 
 
The DG3 tab will display all the decoded fingerprint images on an ePassport (if available). 
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4.5.3 Configuration 
 
There are a number of configuration options provided 
on a tabbed display and accessed by clicking on the 
“Set Read Options” button on the Passport tab, or by 
clicking the Options -> Read Options menu. 
 
Note: after changing any settings, you need to re-
initialise the program by clicking File -> Disconnect, 
then File -> Connect. 

 
  
The Data Groups tab defines the data groups to be 
read, validated and decoded.  It also specifies the 
order in which to request data groups. 
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The Security Checks tab defines which checks to 
attempt and where to find the certificates. 
 

 
  
The Certificate Options tab provides a location for the 
certificate store and file extensions to check. 
 

 
 
 
The EAC tab (EAC build only) enables EAC authentication, defines where the certificates are, and the EAC 
version to use. 
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4.6 Troubleshooting 
 
If the scanner you are having problems with has never worked start with the Installation Check in section 4.6.1 
below. Also start here if the scanner is known to work on other installations but does not work on one particular 
workstation. 
 
If the scanner used to work and has stopped working start at section 4.6.3 and if this does not show the cause 
go back to Installation Check. 
 
Otherwise, if you have a scanner that functions in some modes or reads certain documents then start at section 
4.6.5. 
 
If there are occasional misreads of the OCR line try cleaning the scanner. If the document does not fully insert 
check that there is no debris stuck in the slot. See section 7 for cleaning instructions. 
 
4.6.1 Installation Checks 
 
Undertake the following basic checks if the scanner is found to be faulty in the field. It does not require any 
specialist knowledge or tools. 
 

1.  Check the power cord for damage paying particular attention to 
the AC power plug; ensuring that the pins are straight as shown 
in the picture (you may have a different plug). 

 

2.  Check that the pins on the dc connector are straight and have 
not been pushed back into the connector. 

 

3.  Check that the captive USB cable is pushed as far into the 
scanner as it will go. Do this by pushing on the grey plastic 
moulding on the cable rather than the black metal retaining clip. 
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4.  Ensure that the other end of the USB cable is correctly inserted 
into the workstation PC. If there is a specific USB socket to use 
then make certain it is used. 

 

5.  Plug the power cord into the outlet and the other end into the 
PSU. Do not switch on yet. 

 

6.  Plug the PSU dc output plug into the scanner (arrowed). 

 

7.  Switch on the power outlet and check that the PSU light 
(arrowed) turns green. If it does not light, there may be a 
problem with the power outlet or the PSU. Try swapping the 
PSU for a known working one. 

 

8.  Check that the rear LED on the scanner shows red as shown in 
the picture. If it does not light then the scanner may be faulty. 

 

 

 



Page 34 of 56     

 

 
 

RTE8000 HS Evaluators' Guide 97-0183-15.doc 

 
4.6.2 Device Check 
 
Check that all the devices are connected as shown in section 6.5. 
 
4.6.3 Trouble Shooting Wizard 
 
As part of the binaries installed in the SDK there is a wizard to help in checking for hardware problems. Make 
certain no other applications are running and launch the MMMReaderTroubleShootingWizard.exe. Follow the 
on screen instructions. 
 
For each test screen click the test button and check data appears in the lower window along with a tick. If there 
is a cross, this needs to be referred to your maintenance team. 
 

 

 
For the camera video test use the take snapshot button on each light type and check the results are what you 
would expect. Start the video and stop it. 
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The final screen should look like this: 

 

If any test fails this is probably a hardware issue however it may also be an installation problem.  
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Check that: 
 

•  the drivers are loaded correctly, 
•  the reader has been powered off and on, 
•  the PC has been rebooted, and 
•  you are using USB2.0 cables. 

 
Another possibility is that there is a problem with the format or files within the scanner’s USB Mass Storage 
Device (UMSD). 
 
If the UMSD appears to be correct and is present in the device list, but is not shown in My Computer with a 
drive letter, then there may be a problem with a network drive clashing with the UMSD. This requires the 
Windows Disk Management tool to re-assign the drive letter to one not used by the network drive. 3M have a 
tool that can help, please contact 3M for more information. 
 
4.6.4 HLNonBlockingContainer Tests 
 
The HLNonBlockingContainer.exe program is a simple way of checking for basic communication between an 
application and a scanner. If any of the tests fail but all previous diagnostics has passed then the problem is 
probably software or configuration related.  
 

1.  Start the application and ready it for reading a passport. The rear LED on the scanner 
should now be green. 

  
2.  If the LED does not light or if you receive an on screen error message then this could 

indicate a software configuration problem or a faulty scanner. Try swapping the scanner 
for a known working one. 
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3.  Check that there are no errors shown in the top right hand corner. This error has been 

caused by the scanner not being connected: 
  
 

 
  
4.  Go to the Settings Option and select “Data to Send”, it will bring up a configuration box. 

Set it up so that it looks like the image below and press OK. 
  
 

 
  
5.  Check that the scanner is enabled by using the State option as shown below. 
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6. Go to the images tab and place a document. You should see data and images appear on 

screen. If you are testing RFID then place an ePassport and check both the images and the 
RFID tab.  

  

 
Note:  special documents (e.g. barcodes) will not display in this application but 
you can see the message and its data content in the Timings tab. 

 
4.6.5 Specific Document Problems 
 
If a particular type of document fails to read then you should check these things: 
 

•  Is the document type an optional extra and have you purchased that option? 

•  Have you enabled sending of that data element or security check in your application? 

•  Does the document have good quality printing and in the correct place on the document? 

•  Does the demonstration program support the document type you are trying (use the Timings 
tab on HLNonBlockingContainer.exe on the SDK to see all document messages)? 

•  Is the document type enabled in the [DataToSend] section of the reader.ini file?  See 
sections 4.4.3 and 4.6.4.   

•  If the document type requires an extra plug-in has the relevant #RTEDecode_xxxxx.dll been 
included in the binaries directory?  See section the Plugin Data section of the 3MTM Page 
Reader Programmers' Guide. 

•  If the document type requires an extra plug-in has the relevant #RTEDecode_xxxxx.ini been 
configured correctly?  See section the Scanner Configuration Description in the 3MTM Page 
Reader Programmers' Guide. 

•  If you have a particular problem with an RFID ePassport or some element in a book then this 
is best debugged using the eMRTD Reader program described in section 4.5. 
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5 Customising the scanner 
 
The 3MTM RTE8000 HS scanner is extremely flexible and it can be customised to suit each individual’s 
requirements such as:  
 

•  Data types returned from the scanner 
•  Images taken by the scanner 
•  Sounds  
•  LEDs 
•  Serial settings 
•  Socket settings 
•  Document detection  
•  Advanced settings such as scanner control 

 
 
Settings can either be permanently set by changing the configuration files held in the scanner’s USB Mass 
Storage Device (UMSD) or can be changed temporarily by an application. It is recommended that any 
application using the scanner sets (either permanently or temporarily) the configuration to the parameters it 
needs before commencing to use the scanner.  
 
Settings can be changed in four ways:  
 

•  Manually by editing the configuration files  
•  By clicking the Save Config option in the Page Reader Expo 
•  By clicking the Settings – Save Settings option in the High Level Test container 
•  Programmatically via the API (see the 3MTM Page Reader Programmers' Guide) 

 

 

Note:  that most of the available configuration parameters can only be changed 
either manually or via the API. If editing the files manually it is necessary to either 
restart the application afterwards or reset the scanner via the application. 

 
This section gives an overview of the configuration method and the most commonly used parameters. For a 
detailed description of the settings API and each of the settings see the 3MTM Page Reader Programmers' 
Guide. 
 
A large number of scanner settings can be changed, these range from user preferences to low level variables. 
The settings are organised into three different levels:  
 
5.1.1 Level 1 
 
This is the most restricted settings level. It comprises the least changed settings and those that affect the 
detailed operation of the scanner. 
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The settings at this level include things like OCR variables and can seriously 
affect the performance of the scanner. 
 
These files should only be edited if instructed by 3M and should be not edited 
unless the user fully understands the consequences of changing each setting. 
A more detailed description of each setting is given in the 3MTM Page Reader 
Programmers' Guide. 
 
Modifying the settings in this section can adversely affect the functioning of the 
scanner and should only be done after discussion with your supplier. 

 
5.1.2 Level 2 
 
A restricted level that contains settings suitable for all to change. These are not settings that are altered very 
often but anyone could change them given the relevant instructions. 
 
 
5.1.3 Level 3 
 
These settings are freely available to change and are most frequently changed to alter the basic functions such 
as which data to return. Setting changes at this level will not stop the scanner from functioning. 
 

5.2 Customising the scanner manually  
 
There is a UMSD flash disk inside the scanner which contains all scanner specific settings. The majority of the 
files on this disk are initialisation (.ini) files; it also contains calibration (.dat) and sound (.wav) files. The drive 
can be seen in file explorer when the scanner is connected to a PC. The drive name is RTE8000MSD and the 
setup files are contained in a directory called Unprotected. 
 
If changing the setup files directly, the level 1 and 2 settings can be identified as the filenames that start with a 
hash (#) or underscore (_) respectively. In addition these files have the hidden attribute. 
 

 
These files should only be edited if instructed by 3M and should not be edited 
unless the user fully understands the consequences of changing each setting. 
Each section contains a comment block which specifies the valid values. Never 
guess at a value. A more detailed description of each setting is given in the 3MTM 
Page Reader Programmers' Guide. 

 
The settings files are read when the application enters Reading mode. They can be updated whilst the 
application is running but it must be reset or restarted for the new settings to take effect.  
 
The remainder of this Section will explain the settings of interest. 
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5.2.1 Level 3 Settings – User  
 
5.2.1.1 Scanner Data Settings  
 
The data settings can be modified by selecting the ‘Data To Send’ screen in the High Level Test Container 
‘Settings’ menu option or using the schemes configuration in the Page Reader Expo. If modifying directly, the 
settings can be found in the initialisation file Reader.ini in the [DataToSend] section.  
 
When a document is scanned, all the settings that are turned on will be computed and the results sent to the 
user via a call back function. If there is a possibility that a data item is needed then the setting should be turned 
on. However, if a setting is not required then it should be turned off so that processing time is not wasted in 
obtaining the results. 
 
The standard data list is as follows: 
 

•  Codeline 
•  IR Image 
•  UV Image  
•  Visible Image 
•  Photo Image 
•  e-Passport data 
•  Checksum Test 
•  Barcodes types 
•  Security Checks 
•  Additional visa data 
•  QA 
•  Document Markers 
•  Early codeline 

 

 

Note:  that some items may not be available on some scanners, for example, the 

e−−−−Passport option is required to receive the e-Passport data. 
 
5.2.1.2 Image compression and size  
 
The images obtained from the scanner are JPEG files (other options available contact your supplier). The image 
size and compression can be set to suit the application requirements. Smaller and more compressed images 
take less storage space but larger and less compressed images are of a higher quality. Experiment with 
different compression values to obtain an appropriate balance.  
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The storage space required for an image depends on the compression level. The following table shows the 
sizes in Kilobytes of different full size images at different qualities: 
 

 
Full size image 

Best Quality (KB) 
Compression = 0 

Lower Quality (KB) 
Compression = 70 

IR full image 520 44 

IR codeline only 300 26 

UV colour 700 39 

Visible colour 860 75 

Photo 230 20 

 
The compression settings can be modified by selecting the ‘Data To Send’ screen in the High Level Test 
Container ‘Settings’ menu option or using the schemes configuration in the Page Reader Expo. If modifying 
directly, the settings can be found in the initialisation file Reader.ini in the [DataToSend] section.  
 
If all images are saved ensure that there is enough hard disk space as the storage space requirement soon 
adds up as more and more documents are scanned. 
 
5.2.1.3 Sound Scheme  
 
The sound settings are fully customisable by editing the sound.ini file which is used to configure the sound 
scheme and individual sounds. There are three available sound schemes namely effects, speech and beeps. 
The following events can trigger sounds in the scanner: 
 

•  Read success 
•  Read error 
•  Error 
•  No Connection 
•  Read mode 
•  Update mode 
•  Configuration mode 

 
The effects and speech sound schemes play appropriately named .wav files, which reside on the flash disk 
within the scanner. These files could be replaced by other .wav files if desired, for example, the speech scheme 
files might be replaced by speech files in other languages.  
 

 

Note:  the sounds are played on the PC that is running application and not from 
the scanner hardware. 
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5.2.1.4 LED Scheme 
 
The scanner LEDs can be configured to operate as required. The LEDs can be associated with the following 
events: 
 

•  Power Up 
•  Enable mode 
•  Disable/Sleep mode 
•  Document has been detected 
•  Document can be removed 
•  Good read 
•  Bad read 
•  Test card recognised 
•  Update mode 
•  Standby mode 
•  Read mode  
•  Shutdown 

 
For each LED the options for each event are: 
 

Use LED 0 = Ignore this LED 
 1 = Use this LED 
 -1 = Turn LED off (no need to set other parameters) 
  
State 0 = off 
 1 = red 
 2 = green 
 3 = salmon pink 
  
Flash 0 = solid 
 1 = slow 
 2 = fast 
  
Time 0 = infinite 
 x = time in seconds 

 
Any event will override a previous event so if an LED is set to stay on infinitely in green on document detect, 
and to flash red for two seconds when the document can be removed, then the LED will stay green until the 
document can be removed, then it will flash red for two seconds and turn off.  
 
The LED scheme is specified in the file LED.ini on the flash disk. If this file is not present then the default 
scheme is in use. The file can be requested from 3M if required. See Appendix B of the 3MTM Page Reader 
Programmers' Guide for details of the default scheme for a two LED scanner. 
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5.2.2 Level 2 Settings – Some Caution Required 
 
5.2.2.1 Unrecognised Characters and Document Context 
 
It is possible to change the output for both unrecognised and space characters. The defaults are ‘*’ and ‘_’ 
respectively. It is also possible to turn space detection on and off. The settings are in the file _ocr.ini. 
 
Also found in this file are the context settings for a selection of documents which do not conform to the ICAO 
standard such as French and Spanish ID cards which are enabled by default and old style Australian visas 
which are disabled by default. 
 
5.2.2.2 Active Video 
 
There are two methods of document detection namely active video and basic detection. The basic detection 
looks for the document in certain positions on the glass and is usually set up to look at the back edge of the 
glass. The active video detects documents anywhere on the glass and document detection is triggered as soon 
as the document stops moving. If the requirement is for the document to be pushed right to the back edge of the 
glass then the active video can be switched off.  
 
The active video setting can be found in the file _function.ini: 
 

[DocDetect]Anywhere=1  

 
5.2.2.3 Extras 
 
The operation of non-basic OCR functions is controlled using a range of module unique files with names 
conforming to #RTEDecode_XXXX.ini where XXXX is the module name, for instance 
#RTEDecode_1dBarcodes.ini. The individual files need to modified to enable the correct types. 
 

 
Modifying the settings in this section can adversely affect the functioning of the 
scanner and should only be done after discussion with your supplier. 

 
If a specific document is not reading it is worth checking that the document type is enabled in these files. 
 
5.2.3 Level 1 Settings – Restricted Use 
 
5.2.3.1 Operating Modes 
 
Enable/Disable 
 
The scanner can be set up to either read whenever a document is placed on the glass, or to read a document 
only when instructed.  
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The instruction takes the form of an Enable command. When the Enable command is received, if there is a 
document on the scanner it will be read, otherwise the scanner will read the next document that is placed on the 
scanner.  
 
There is also a Disable command, which can be used to cancel the Enable command.  
 
Another way to look at these modes is that if Enabled the scanner will asynchronously read a document and 
send data whilst in Disabled mode the client application can implement a polled or prompted document read. 
 
Sleep Mode 
 
Sleep mode is a deeper version of disabled. When in disabled mode the scanner can still detect documents 
however in sleep mode this detection is switched off. The scanner is essentially not doing anything except 
responding to commands and therefore consumes minimal CPU resources and electrical power.  
 
Suspended Mode 
 
Suspended mode is like Sleep mode but in addition to turning off document detect it also disables the RFID 
interface. This mode consumes even less CPU resources and electrical power.  
 
Auto Disable Mode 
 
The scanner can be set up to auto disable after it has read a document. In this mode an Enable command must 
be sent to the scanner every time a document is to be read. This gives precise control over when the scanner is 
able to read a document and is suitable for applications such as Self Service Kiosks. The Disable command can 
also be sent to cancel an Enable if a document is not read in the mean time. 
 
Normal Read Mode 
 
The scanner will read any document that is placed on the glass. In this mode the scanner does not get disabled 
when a document is read. The Disable command can be sent to stop the scanner from reading if required at 
any stage, the Enable command will clear the disable.  
 
In any mode it is possible to start the scanner either enabled, disabled, sleep or suspended.  
 
These modes are best controlled via the API and it can be demonstrated in both the 3MTM Page Reader Expo 
and the High Level Test Container. 
 
If the application is restarted or the scanner power is recycled then the mode will default to the startup mode. 
The startup and auto disable mode is specified in the file #Reader.ini.  
 

 
Note:  This file is a level 1 file so take care not to change any other values in this 
file. 
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5.2.3.2 UV Scheme 
 
The UV illumination is a cathode tube which takes time to warm up and the life of which can be preserved by 
turning it off whenever practical. A UV scheme has been implemented to best accommodate the requirements 
of both the user and the UV tube. 
 
A warm-up time is specified, which ensures that a document is not read before the warm up time of the tube. If 
a document is placed on the glass within the warm-up period, it is held until the period has passed before the 
UV image is taken and the remaining processing is performed. The LED and sounds signify that the document 
cannot be removed. The default time for the UV warm up is six seconds.  
 
The UV is turned off when the scanner has not been used for a period of time. The default time period is an 
hour. 
 
The UV scheme is set in the level 1 file #Reader.ini under the section UVPower.  
 
5.2.3.3 Advanced Tube Saving Scheme 
 
In this scheme the UV is turned on when the scanner is enabled and off when the scanner is disabled. There is 
a delay between disabling the scanner and the UV being turned off, this delay defaults to 15 seconds but can 
be set to any value.  
 
The scheme should only be used in situations where the scanner can be enabled at least six seconds before it 
is used, otherwise each document will be held until the end of the warm-up period and the scanner will appear 
extremely sluggish. For scanners set to auto disable then the UV will also automatically disable after the delay 
period. The delay is used so that if a second scan is required it can be performed without the initial warm-up 
period of the tube. 
 
Advanced tube saving is set in the level 1 file #Reader.ini under the section Status. 
 
5.2.3.4 Upside Down Documents 
 
The 3MTM Page Reader SDK is set to read documents that are placed on the glass at any orientation. It is 
possible to turn off the reading of documents when they are upside down, this will give a speed increase in the 
recognition but obviously will not read upside down documents. 
 
Upside down documents can be turned off in the level 1 file #Reader.ini under the section TestMode. 
 
5.2.3.5 Document Debarrelling 
 
The images from the scanner have a small amount of barrel distortion caused by the lens. For most applications 
this is negligible however it is possible to use the API to provide a correction for this called debarrelling. This 
can be tested using the Low Level Test Container. 
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6 How to install a scanner 
 

6.1 General installation 
 

 
Warning:  Before use check that the power cord is suitable for use in your country 
and the local power supply. Check the voltage and plug is suitable for your local 
supply. The PSU requires 100-240Vac at 2.2A. 

Substitution of the provided power cord and/or accessory PSU may void any 
regulatory approvals that the equipment may have. If in doubt contact your 
supplier or manufacturer. The equipment must be installed near an easily 
accessible socket outlet. 
 

 
Warning:  For indoor use only. Dangerously high voltages are present inside the 
scanner and the PSU. Do not open or take apart either unit. No user serviceable 
parts inside, refer all servicing to qualified personnel or contact your supplier. 
 

 
Caution: Do not look direct into the light of the UV lamp for a long time. Keep a 
safety distance of 30 cm (1 feet) minimum from the light source. Handle or 
transport unit carefully. The UV tube inside could break if the units drops. 

 
 
The scanner is designed to operate in a standard office environment.  
 

•  It should not be exposed to extremes of temperature or humidity.  

•  It is not protected against dust or liquid ingress.  

•  Consideration must be given to the optimum position for operator access. Guidance should 
be sought from national regulations for ergonomic layout of office equipment. 

•  Do not site near to generators of electro-magnetic fields such as monitors, power supplies, 
motors, fluorescent light banks, mobile phones, two-way radios, etc. 

 

 Do not connect the scanner to the PC prior to installing the drivers and software 
on the PC. 

 

6.2 Software Installation 
 

 

 

Note:  The PC must be Windows 2000 SP4, Windows XP SP1-3, Windows Vista or 
Windows 7. 64bit drivers are available – contact your Global Technical Service for 
further information. You must have a properly installed High Speed USB2.0 port 
available. 
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1. Place the Installation CD into the drive and if it doesn’t auto-start then run setup.exe on the 
root directory of the CD. Follow the on-screen instructions to install all the drivers, software, 
demonstration programs and SDK. 

 
 

 

Note:  If your organisation already uses the 3MTM RTE8000 HS it may have created 
an installation of its own application. Check with your IT department before 
proceeding. 

 
 

2. Ensure that DirectX is loaded and up to date. This is on the installation CD or visit 
www.microsoft.com. 

 
 
The installation consists of 3 parts: 
 

•  3MTM Full Page Reader Device Drivers 

•  The 3MTM Page Reader Software Development Kit (SDK), which includes evaluation 
programs 

•  A binaries directory for the main applications 

 
When rolling out an application you may not need to install the full SDK and either require just the USB device 
drivers and maybe the binaries. The USB device drivers are a separate executable that can be included in your 
own release package. 
 

6.3 Connecting your scanner 
 

 

 
Do not connect the scanner to the PC prior to installing the drivers and software 
on the PC. 

 
 
The scanner must be connected as shown in the diagram below adhering to all instructions.  Note the 
Warnings and Cautions in the General Installation section 6.1 above. 
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6.4 Using the Hardware Installation Wizard 
 
Windows 2000 and Windows XP will request a driver installation each time you place the scanner into a new 
USB port on your PC. However once it has installed the drivers for that port you can change scanners without 
being requested to install new drivers. 
 
 
The first time the scanner is switched on it will require Windows to go through the “New Hardware Wizard”. The 
drivers will then start to install.  
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There are two types of drivers one for the scanner and the other for the e-passport chip reader. 
 

 
Note: They are both signed so should install automatically. If the windows 
hardware wizard requires the drivers to be installed follow the instruction below. 

 
1. On Windows XP SP2 select "No, not this time" to the question "Can Windows connect to 

Windows Update to search for software?”  
 

 
Note: This screen can be disabled from the Hardware tab of the System 
Properties window. 

 
 

 
  
2. When prompted for the scanner drivers (these will be called "Rochford Thompson 

Unconfigured Device" and "RTE8000") follow the on-screen instructions. 
  
3. Select the "Install the software automatically" or "Search for best driver" option if prompted. 
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4. If the RFID option is installed you may be prompted for the e-passport chip reader drivers 

(these will be called "RT USB RFID Reader") follow the on-screen instructions. 
  
5. Select the "Install the software automatically" or "search for best driver" option when 

prompted.  
  
 

 
 
 

6.5 Checking the Scanner is plugged in and working 
 

Windows XP 
  
1. Open the "My Computer" icon on the Desktop or from the Start Menu. 
  
2. Check that you see a  3M RTE8000 HS Camera X4  in the Scanners and Cameras section 

and a new Removable Drive labelled RTE8000MSD. 
 

 
Note:  If you can’t see these items then consult the troubleshooting section of 
the 3MTM RTE8000 HS Getting Started Guide found on the CD. 
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Windows 2000 
  
1. Go to the "Control Panel" from the Start Menu and Select "System" and go to the "Device 

Manager".  
  
2. Check that you see an 3M RTE8000 HS Camera is in the "Imaging Devices" section and a 

"RTE8000 UsbFlashDisk" or similar (e.g. "USB 2.0 FlashDisk USB Device") drive in the 
Disk Drive section. 

 

 
Note:  If you can’t see these items then consult the troubleshooting section 4.6. 

 

RFID Option (Windows XP and Windows 2000) 
  
1. Go to the "Control Panel" from the Start Menu and Select "System" and go to the "Device 

Manager" as shown in the picture above.   
  
2. Check that you can see an “RT USB RFID Reader” in the “Ports (COM and LPT)” section. 

 

 
Note:  If you can’t see this item then consult the troubleshooting section 4.6. 
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6.6 Uninstalling the Drivers and SDK 
 
To uninstall the software use the Windows Control Panel component “Add or Remove Programs”.  
 
To remove the drivers, click on the item “3M(TM) Full Page Reader Device Drivers” and select 
Change/Remove.  
 
To remove the software package and SDK click on the item “3M(TM) Page Reader SDK” and select 
Change/Remove. Then follow the instructions on the pop-up windows. 
 
Under Windows Vista open the Control Panel application, go to the Programs section, or click the link directly 
underneath the Programs heading called “Uninstall a program”. 
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7 Cleaning the Scanner  
 
The 3MTM RTE8000 HS scanner should be cleaned regularly, depending on use, for best performance and 
correct operation. Cleaning will remove dirt and grime that may have been deposited from scanned documents 
as well as general dust. 
 

7.1 3MTM RTE8000 HS Semi-Enclosed (Enhanced) Hood 
 
If paper or sticky residue is caught at the back of the document slot then refer the cleaning to a maintenance 
engineer and follow the procedure outlined in the Maintenance Manual. 
 
Required items: 
 

•  Alcohol soaked cleaning card (RT Part Number 80-0062-99) 

•  Lint free cleaning cloth. 

 
1. Use the lint free cleaning cloth to wipe away dust from the scanner exterior. 
  
2. Use the alcohol soaked cleaning card to clean the glass surface. To do this: 

 
•  Take the cleaning card out of its packaging.   

 

 
Note that if you have sensitive skin you should use a disposable plastic glove 
that you are not allergic to. 

 
 

•  Insert the card as shown into the scanner’s 
document slot (between the hood and glass 
surface) until it is stopped by the back edge. 

  
•  Move the card sideways back and forth 

(arrows) whilst gently keeping the card 
pushed towards the back edge of the 
document slot as this is where dust and dirt 
may have accumulated the most. 

 

 

  
3. Take the card out and turn around (180 degrees) and repeat so that the other (clean) end of 

the cleaning card is used to clean any remaining dirt. 
  
4. Take the card out and examine the dirt on the cleaning card. If the card is very dirty then 

repeat using a fresh cleaning card. 
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5. It may be necessary to fold the top 2 cm 

(arrowed) of the cleaning card for added 
thickness and then repeat the above steps 
for removing stubborn marks. 

  
6. After cleaning, leave scanner glass surface 

to dry for 5 minutes before use.  
 

7.2 3MTM RTE8000 HS SSD Open Hood  
 
Required items: 
 

•  Alcohol soaked cleaning card (RT Part Number 80-0062-99) 

•  Lint free cleaning cloth. 
 

1. Use the lint free cleaning cloth to wipe away dust from the scanner exterior. 
  
2. Use the alcohol soaked cleaning card to clean the glass surface. To do this: 
  
•  Take the cleaning card out of its packaging.  

 

 
Note that if you have sensitive skin you should use a disposable plastic 
glove that you are not allergic to. 

 
 

  
•  Move the card sideways back and forth whilst gently keeping the card pushed 

towards the back edge of the document slot as this is where dust and dirt may have 
accumulated the most. 

  
•  Make certain you cover the whole window area paying particular attention to the rear 

edge and corner where dust can build up. 
  
3.  Take the card out and turn around (180 degrees) and repeat so that the other (clean) 

end of the cleaning card is used to clean any remaining dirt. 
  
4.  Take the card out and examine the dirt on the cleaning card. If the card is very dirty 

then repeat using a fresh cleaning card 
  
5.  After cleaning, leave scanner glass surface to dry for 5 minutes before use. 
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Appendix A 3MTM RTE8000 HS Technical Specifications 
 
Part Number: RT80-04-XX-XX-XX-XX-XX 

Acquisition and analysis time: ICAO format codelines in less than 1 second. 

Light sources: Visible (RGB), Infra-red (B900 band at 875nm), Ultra-violet UV-A (365nm). 
Optional 3M™ Confirm™ (24 Bit Colour, 8 Bit Monochrome IR) 

Document window size: 130 x 100 mm (5.1 x  3.9 inches) 

Image resolution: • Sensor: 3.1 Megapixels, CMOS, RGB 24 bit colour system 
• Standard 400 DPI image resolution 

Image formats: Standard jpg. Optionally bmp, tif, gif and png. 

Read Capabilities (Optical reader): • ICAO compliant documents in near infrared (IR) per ICAO 9303 
specification Parts 1-4 

• 1D barcodes (IATA 2 of 5, Industrial 2 of 5, Interleaved 2 of 5, Code 128, Code 39, 
EAN 8 and EAN13) 

• 2D barcodes (PDF 417, QR, DataMatrix and Aztec formats) from paper documents 
and most mobile devices 

• Optional IATA ticket (TAT and ATB) fonts 407-E, 1403M, OCRB and OCRA. 
• Optional 3M™ Confirm™ 

Optional RF Reader for e-Passports: Fully integrated ISO 14443 Type A & B compatible RF reader for e−Passports. 
Supports autodetection, anti-collision, high speed transmission up to 848Kbps. 

Host Interface: USB2.0 high speed (does not take power from port) 

Auxiliary device interfaces: USB2.0 high speed (option) 

Optional software interfaces: Serial port emulations, keyboard wedge. 

Operator Indicators: 2 user LEDs including power/self test indication. 

Power Requirements: Universal input external power supply: 

AC Input: 100 - 240 Vac, 50 - 60 Hz 

DC Output: 12 Vdc, 2.2A max. 
Typical DC current consumption: 0.65A 

Dimensions: Depth: 200 mm (7.9") 

Width: 191 mm (7.5") 

Height: 158 mm (6.2") 

Environmental:  Operating Temperature: 0ºC - 40 ºC. Operating Humidity: 40% - 90% RH (non-
condensing) 

Typical host system requirements: Pentium P4 1.7 GHz class running Windows 2000 SP4, Windows XP, Windows Vista,  
Windows 7, 512Mb RAM, 60Mb of Hard Drive space. USB2.0 high speed interface. 
For Linux support contact your local 3M Office. 

Compliance: FCC and CE certified (CB report available). 

Supplied Software Development Kit (SDK) Full SDK including dlls, test / maintenance applications and demonstration programs. 
Support for Visual C++ , C#, .NET, Visual Basic .NET, Java,  C++ Builder and Delphi. 

 
 
 
 
 


